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CLUSTER OF SUSPECTED 
MENINGOCOCCAL DISEASE IN 
GLASGOW NURSERY 

The PHPU was alerted to 3 cases of suspected 
meningococcal septicaemia which occurred within a month in 
the same Glasgow nursery. In accordance with national 
guidelines (CDR Review Vol 5, Review number 13, 8 Dec 
1995), chemoprophylaxis was offered to all children and staff 
members of the nursery. Letters from the PHPU advising 
parents/staff to obtain antibiotics from their GPs were 
distributed to over 100 contacts. GPs, including those outwith 
our health board area, were notified by fax. Given the 
number of contacts, it was not possible to fax letters with 
individual patient details to GPs within an acceptable time-
frame. A general letter was therefore faxed to the 70 
practices informing them of the cluster and explaining that a 
contact might arrive with the PHPU letter requesting a 
prescription.  Two of these suspected cases have since been 
confirmed as group B infections. All 3 patients have fully 
recovered.  

As you are aware, this is the season for influenza and, 
having an association with meningococcal disease (m.d.), we 
see the prevalence of m.d. rise in the winter months . This is 
reflected in the notification rates for the winter months 2000-
01 and summer months 2001. Last month alone we received 
10 notifications.   
Oct 00 - March 01               43 cases 
Apr 01 - Sept 01 17 cases 
Oct 01    10 cases 
 
We would like to take this opportunity to stress to GPs that 
where meningococcal disease is suspected, the patient 
should immediately be given a single injection of IV/IM 
benzylpenicillin before being urgently transferred to hospital. 
This is the recommendation of the Department of Health's 
Chief Medical Officer. 
 
Benzylpenicillin dose : 
 
Adults and children >10years 1200mg 
Children 1-9 years of age 600mg 
Children under 1 year of age  300mg 
 
IMPORTANT  
A single injection may be life-saving and will not interfere 
with subsequent management. 

        
        
 

IMMUNISATION UPDATE 
 
• Pre-school acellular pertussis booster 
 
It is planned that the routine immunisation programme is to 
be modified from January 2002 by the introduction of a pre-
school booster vaccination against whooping cough 
(pertussis) as part of a combined diphtheria, tetanus, 
acellular pertussis (DTaP) vaccine.   
 
The current immunisation programme against pertussis 
consists of a series of primary immunisation at 2, 3 and 4 
months of age. Despite high vaccine uptake (about 95%), 
pertussis continues to be the cause of significant morbidity 
and mortality in children too young to be fully protected and 
there is evidence that these babies may be catching 
pertussis from older siblings or possibly parents.  The Joint 
Committee on Vaccination and Immunisation (JCVI) has 
considered whether the introduction of a booster dose of 
pertussis vaccine would help reduce the levels of morbidity 
and mortality.  Based on the mathematical modelling, the 
Public Health Laboratory Service has demonstrated that a 
booster will reduce illness in older age groups and reduce 
the transmission of pertussis to babies too young to be fully 
protected.   
 
Acting on this evidence, the JCVI has therefore 
recommended that a booster dose of pertussis vaccine be 
introduced into the routine pre-school immunisation 
programme. 
 
Further details about this programme will be sent to all 
primary care team members soon by the Scottish Executive 
with appropriate information leaflets for parents and support 
material for health professionals. 
 
• Meningococcal vaccines 
 

 As you are aware, outbreaks of meningococcal infection due 
to a strain rarely seen in the UK – called W135 – occurred in 
association with the annual Moslem Hajj pilgrimage in Saudi 
Arabia in both 2000 and 2001.  Neither the meningococcal 
group C conjugate vaccine (MenC) nor the meningococcal 
polysaccharide A&C vaccine protect against the W135 strain.  
It is therefore important that all pilgrims to Saudi Arabia 
receive the quadrivalent ACWY Vax which provides 
protection against W135 meningococcal disease as well as 
the A and C strains.  Vaccine can be ordered from the 
manufacturers on 0808 100 9997.  Proof of immunisation 
against meningococcal infection is a visa requirement for 
pilgrims entering Saudi Arabia.  Some pilgrims may still have 
a valid certificate following a previous immunisation with A&C 
vaccine.  If travelling on Hajj again, they still require the 
additional protection afforded by the quadrivalent vaccine. 
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The new MenC vaccine has drastically reduced the number 
of cases of meningococcal C meningitis and septicaemia 
throughout all vaccinated age groups.  However, there is not 
yet a vaccine to protect against other strains such as 
meningococcal group B which is the main cause of 
meningococcal illness in the UK.  As winter approaches, 
colleagues are reminded to remain alert to the possibility of 
meningococcal disease in patients of any age presenting 
with any of the signs or symptoms of meningitis or 
septicaemia. 

 
Colleagues are again reminded that all new entrant full-time 
students to colleges and universities who have not received 
either the Men C (conjugate) or A&C (polysaccharide) 
vaccine should have a Men C vaccine as soon as possible.  
GPs are eligible to claim an item of service fee for this 
service. 
 
 
• MMR    Update            
 
Colleagues in primary care should, by now, have received 
the MMR discussion pack produced by the Health Education 
Board for Scotland on behalf of the Scottish Executive.  
However, since the publication of the discussion pack, a 
report on the review that has been undertaken by the Irish 
Parliament’s Joint Committee on Health and Children has 
been published.  This review fully supports the use of MMR.  
Another study just published in Pediatrics has found no 
evidence for a new variant of Measles-Mumps-Rubella 
induced autism.  It concludes, 'No evidence was found to 
support a distinct syndrome of MMR-induced autism or of 
“autistic enterocolitis".  These results add to the recent 
accumulation of large-scale epidemiological studies that all 
failed to support an association between MMR and autism at 
population level.  When combined, the current findings do 
not argue for changes in current immunisation programmes 
and recommendations '. 1 

 

 
             1No Evidence for A New Variant of Measles-Mumps-Rubella-

Induced Autism’ (Fombonne E, Chakrabarti S); Pediatrics 
2001; 108(4). 

 http://www.pediatrics.org/cgi/content/full/108/4/e58 
 
 
 
 
 
ASPLENIC PATIENTS  
 
Overwhelming postsplenectomy infection should be 
preventable if simple precautions are taken. Most instances 
of serious infection are due to encapsulated bacteria such as 
Streptococcus pneumonia, Haemophilus influenza type b, 
and Neisseria meningitidis (meningococcus).  Pneumococcal  
infection is most common and carries a mortality of up to 
60%.  
 
The immunisation regime for asplenic patients is as follows: 2   
 
• Pneumococcal vaccine : - every 5-10 years  
• H influenza type b : -  once-only vaccination  
• Men C : - once-only vaccination   
• Influenza : -  every year 
 
2 Guidelines for the prevention and treatment of infection in 
patients with an absent or dysfunctional spleen BMJ 1996 ; 
312: 430-4 
 
 

OUTBREAK OF E. COLI O157 AT A 
CHRISTENING IN CAMBUSLANG 
 
An outbreak of gastroenteritis caused by infection with 
Escherichia coli O157 occurred at a christening function in 
Cambuslang on 9th September 2001. 90 guests attended the 
event where a buffet was privately supplied.  The first cases 
were notified to the PHPU on 21st September 2001. 
 
The outbreak resulted in 1 probable and 6 definite cases 
although none was hospitalised. Two children were 
periodically reviewed as outpatients at Yorkhill hospital to 
monitor their renal function in view of their risk of developing 
the Haemolytic Uraemic Syndrome (HUS) - neither child 
developed this complication. 
 
Despite intensive Environmental Health investigations of the 
food handlers and food outlets which supplied the buffet and 
analysis of questionnaire information from the cohort, no 
foodstuff or food outlet was found to be associated with the 
outbreak. However, the epidemiological evidence supported 
the hypothesis that the most likely cause of the outbreak was 
contaminated food served at, or saved from, the function. 
 
This outbreak highlights :  
 
• That GPs, being the first health personnel to come into 

contact with possible cases, are crucial in the early 
identification of outbreaks. GPs should have a high 
index of suspicion for any patient presenting with bloody   
diarrhoea.  All such patients should be asked to submit 
faecal samples.  
 

• The importance of meticulous food preparation, food 
storage, hand hygiene and appropriate disinfection 
procedures in reducing the risk of infection with not only  
E. coli O157 but all organisms responsible for food 
poisonings. 

 
 
SUSPICIOUS MAIL PROTOCOL  

 
The PHPU was recently involved in two separate incidents  
where mail-room workers were exposed to unknown 
substances contained within postal packages.  In both cases 
the substances proved to be harmless. We should stress that 
intelligence sources indicate that the risk of bio-terrorist 
attacks in the U.K. is low.  
 
The PHPU, Strathclyde Police and Glasgow City Council 
(including Scientific Services) have agreed and endorsed a 
short protocol governing the management of such incidents 
in the GGNHSB area.  
 
In summary : -  
 
• All suspect packages/suspicious substances should be 

reported to the local police in the first instance 
• The police will assess the situation and, if concerned, 

will contact the Consultant in Public Health Medicine 
(CPHM), SCIEH and the Specialised Services.  

• If exposure to a hazardous substance is suspected then 
steps will be taken by the agencies to control spread of 
contamination within the affected area and organise 
decontamination of those exposed.  

• A further risk assessment will be conducted by the 
agencies and, if indicated, prophylactic antibiotics will be  
prescribed for those exposed.  

• The police and Specialised Services will organise 
removal of the substance and complete the 
decontamination process. 

http://www.pediatrics.org/cgi/content/full/108/4/e58
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More information regarding release of biological or chemical 
agents is available on PHLS website www.phls.co.uk  
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 S I D E B A R  A R T I C L E S  Instructions for Using This 

continued from page 1 
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This sidebar article was created with a text box. You can use 
a sidebar article for any information you want to keep 
separate from other articles or information that highlights an 
article next to it. These could include a list of contributors, 
addresses or contact information, a smaller self-contained 
story, a preview of the next issue, or a calendar of schedule. 
The example below shows a Calendar of Events. 

C A L E N D A R  O F  E V E N T S  
SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here. 

SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here.  

SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here.  

SPECIAL EVENT 

PLACE 
TIME 
Type a description of your event here. 

Template 
Type your sub-heading here 

Your By-line 
Your Company Name 

To keep these instructions, choose Print from the File 
menu. Press Enter to print the template. Replace the 
sample text with your own text to create your 
newsletter. 

Using Styles in This Template 
To change the Style of any paragraph, select the text 
by positioning your cursor anywhere in the paragraph. 
Select a Style from the drop-down Style list at the top-
left of your screen. Press Enter to accept your choice. 

 

See Page 4 to learn how to edit or replace this picture. 

The styles available in this template allow you to 
change the look of your headlines and other text. The 
following is a list of some common styles and their 
uses. 

Body Text - Use this style for the regular text of an 
article. 

Byline - Use this style for the name of the author of an 
article. 

Byline Company - Use this style to type the author’s 
company. 

SIDEBAR HEAD - Use this style to type a second-level 
heading in a sidebar article. 

SIDEBAR SUBHEAD - Use this style to type a third-level 
heading in a sidebar article. 

Sidebar Text - Use this style to type the text in a 
sidebar article



 
 
 M O R E  W A Y S  T O  C U S T O M I Z E  T H I S  
T E M P L A T E  

Inserting and Editing 
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Return Address 
Street Number and Name 
City, State  98765-4321 
 

 BULK RATE 

US POSTAGE 

PAID 

PERMIT NO. 

98765 

  
ADDRESS CORRECTION REQUESTED Mailing Address 

Street Number and Name 
City, State  98765-4321 

 
 
 
 

FOOTERS 

To change the text at the very bottom of each page of your 
newsletter, click Headers and Footers on the View menu. 
Use the Header and Footer toolbar to open the footer, and 
replace the sample text with your own text. 

INSERT SYMBOL 

It is a good idea to place a small symbol at the end of each 
article to let the reader know that the article is finished and 
will not continue onto another page. Position your cursor at 
the end of the article, click Symbol on the Insert menu, 
choose the symbol you want, and then click Insert. 

BORDERS 

You can use page borders and text box borders to change 
the appearance of your newsletter. Borders on text boxes 
help keep different articles separate, and can set off sidebar 
articles from the rest of the page. To change a text box 
border, select it, double click its edge and choose the Colors 
and Lines tab in the Format Auto Shape dialog box. 

Pictures 
Type your sub-heading here 

You can replace the pictures in this template with your 
company’s art. Select the picture you want to replace, 
point to Picture in the Insert menu, and click From File. 
Choose a new picture and then click Insert. Select the 
Link to File box if you don’t want to embed the art in 
the newsletter. This is a good idea if you need to 
minimize your file size; embedding a picture adds 
significantly to the size of the file. 

To edit a picture, click on it to activate the Picture 
toolbar. You can use this toolbar to adjust brightness 
and contrast,  

Choose a new picture, and click the Link to File 
box if you don’t want to save the art with the 

newsletter. 

change line properties and crop the image. For more 
detailed editing, double-click on the graphic to activate 
the drawing layer. ! 
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